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Abstract

Although reflectometry had not been considered as a primary application of GPS and similar Global Navigation Satellite Systems

(GNSS), fast-growing GNSS tracking networks has led to the emergence of GNSS interferometric reflectometry technique for

monitoring surface changes such as water level. However, geodetic GNSS instruments are expensive, which is a limiting factor for

their prompt and more widespread deployment as a dedicated environmental sensing technique. We present a prototype called

Raspberry Pi Reflector (RPR) that includes a low-cost and low-maintenance single-frequency GPS module and a navigation

antenna connected to an inexpensive Raspberry Pi microcomputer. A unit has been successfully operating for almost two years

since March 2020 in Wesel (Germany) next to the Rhine river. Sub-daily and daily water levels are retrieved using spectral

analysis of reflection data. The river level measurements from RPR are compared with a co-located river gauge. We find

an RMSE of 7.6 cm in sub-daily estimates and 6 cm in daily means of river level. In August 2021, we changed the antenna

orientation from upright to sideways facing the river. The RMSE dropped to 3 cm (sub-daily) and 1.5 cm (daily) with the

new orientation. While satellite radar altimetry techniques have been utilized to monitor water levels with global coverage,

their measurements are associated with moderate uncertainties and temporal resolution. Therefore, such low-cost and high-

precision instruments can be paired with satellite data for calibrating, validating and modeling purposes. These instruments

are financially (< US$ 150) and technically accessible worldwide.
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Key Points:

 We present a prototype system for tracking water levels called the Raspberry Pi Reflector
with centimeter level accuracy

 It consists of cost-effective single-frequency Global Positioning System module and 
navigation antenna connected to Raspberry Pi microcomputer

 It uses Interferometric Reflectometry technique and can be operated safely in extreme 
weather with lower operational costs
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Abstract

Although reflectometry had not been considered as a primary application of GPS and similar
Global Navigation Satellite Systems (GNSS), fast-growing GNSS tracking networks has led to
the emergence of GNSS interferometric reflectometry technique for monitoring surface changes
such as water level. However, geodetic GNSS instruments are expensive, which is a limiting
factor for their prompt and more widespread deployment as a dedicated environmental sensing
technique. We present a prototype called Raspberry Pi Reflector (RPR) that includes a low-cost
and low-maintenance single-frequency GPS module and a navigation antenna connected to an
inexpensive Raspberry Pi microcomputer. A unit has been successfully operating for almost two
years since March 2020 in Wesel (Germany) next to the Rhine river. Sub-daily and daily water
levels are retrieved using spectral analysis of reflection data. The river level measurements from
RPR are compared with a co-located river gauge. We find an RMSE of 7.6 cm in sub-daily
estimates  and 6 cm in daily  means of  river  level.  In  August  2021, we changed the antenna
orientation from upright to sideways facing the river. The RMSE dropped to 3 cm (sub-daily)
and 1.5 cm (daily) with the new orientation. While satellite radar altimetry techniques have been
utilized to monitor water levels with global coverage, their measurements are associated with
moderate  uncertainties  and temporal  resolution.  Therefore,  such low-cost  and high-precision
instruments can be paired with satellite data for calibrating, validating and modeling purposes.
These instruments are financially (< US$ 150) and technically accessible worldwide.

1 Introduction

1.1 Background

One of the challenges for hydrologists and environmental scientists is the need to obtain and

sustain  in-situ water  level  measurements  for  calibrating  and  improving  models,  validating

satellite  and  airborne  products,  and  developing  early-warning  flood  systems.  Ground-based

measurements are still scarce in many regions. In particular, stream flow monitoring gauges have

been declining sharply since the mid 1980s due to high maintenance cost, funding shortfall and

(geo-) political constraints (Hannah et al., 2011; Ruhi et al., 2016, 2018; Reid et al., 2019). While

satellite remote sensing techniques have been utilizing to monitor oceanic and land surface water

with  unprecedented  global  coverage,  their  measurements  are  associated  with  moderate

uncertainties and temporal resolution. Measurements of sea surface and river water level using

ground-based sensors are conventionally relying on contact methods, such as traditional float and

stilling well gauges (Noye, 1974) and bubbler pressure gauges (Pugh, 1972), or proximal sensing

gauges,  such  as  acoustic  (Gill  & Mero,  1990;  Boon  & Brubaker,  2008)  and  radar  sensors

(Woodworth & Smith, 2003; Costa et al., 2006). These commercial sensors are typically costly at

approximately a range of few hundreds (e.g., pressure gauge) to a few thousands of U.S. dollars

(e.g., radar sensors). Their installations are often restricted to  a  specific structure close to the
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river  such as  a  stilling well,  a  mast  or  a  bridge. However,  recent  advances  in  commutation

technology,  open-source  hardware,  microcontrollers  and  single-board  computers  such  as

Internet-of-Things, Raspberry Pi computers, and GPS chipsets are transforming scientific data

collection,  offering  a  new  way  forward  on  the  use  of  low-cost  sensors  for  environmental

monitoring.

Open-source do-it-yourself sensors can vastly reduce acquisition costs – which is a major

barrier to collecting in situ water level data. In recent years, the use of inexpensive sensors has

gained popularity in surface water monitoring and has shown great promise (e.g., Mao et al.,

2020;  Knight  et  al.,  2020).  Paul et  al.  (2020) developed a cost efficient  lidar-based distance

sensing  prototype  to  monitor  river  water  level  (<  $150  U.S.  dollars)  which  has  accuracy

inversely proportional to distance, of about 1 cm for measurement distances below 10 m under

operating temperatures of 10o-30o C. Inexpensive pressure sensors such as MS5803 have been

recently combined with low-cost Arduino microcontrollers to provide sea-level data (Beddows et

al., 2018; Lyman et al., 2020). Knight et al. (2021) showed that while these pressure sensors can

resolve water elevations to 1 cm accuracy in laboratory settings, the effect of large waves during

high  water  fluctuations  and  storms  can  significantly  reduce  the  quality  of  water  level

measurements. 

Water level can also be measured directly by means of buoys and gliders equipped with

GPS  and similar Global Navigation Satellite  Systems (GNSS) instruments.  Using a low-cost

GNSS receiver (U-blox M8T) and a patch antenna (Tallysman TW4721) on a buoy, Knight et al.

(2020) designed a unit to measure sea level with RMSE of 1.4 cm compared to a conventional

tide gauge. This real‐time kinematic (RTK) positioning method requires a coastal GNSS base

station at a known fixed location to allow observations relative to the moving receiver on buoy;

this  is  likely  a  significant  limiting  factor for  adoption  of  this  method.  Penna  et  al.  (2018)

demonstrated a GNSS glider based on Precise Point Positioning (PPP), which does not require a

base station. A more serious issue to these contact methods (pressure gauges and GNSS floats)

concerns safety and sustainable monitoring due to direct exposure to the water.

1.2  GNSS Interferometric Reflectometry for Water Level Measurements

GNSS Interferometric Reflectometry (GNSS-IR) is an emerging technique in geodesy that has

shown remarkable contributions to ground-based sea and lake level monitoring (Larson et al.,
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2013b; Roussel et al., 2015; Strandberg et al., 2016; Geremia-Nievinski et al., 2020; Holden &

Larson, 2021). Although GNSS-IR is not the primary application of GPS/GNSS (positioning,

navigation  and timing),  the  fast  growth of  GPS/GNSS base station networks  has  led  to  the

emergence of this technique for monitoring surface changes such as sea and river level. Unlike

GNSS positioning applications that rely on carrier phase and pseudorange observables, GNSS-IR

is based on Signal-to-Noise Ratio (SNR) data recorded by the receiver. Geodetic-quality GNSS

receivers  and antennas,  however,  are  still  very  expensive  instruments  (>$10,000),  a  limiting

factor for use as a dedicated environmental sensor. While several low-cost GNSS-IR sensors are

now available (see below for further details), they typically work best in coastal ocean regions

and lakes where satellite signals are reflected off a relatively large extent of water body. A river is

a  more  challenging  environment  for  measuring  water  level  because  of  the  need  to  restrict

observations over a much narrower region.  

GNSS-IR is redefining its  role as an innovative technology in environmental sensing.

Williams et al. (2020) demonstrated the potential of a low-priced GPS receiver ($30 U.S. dollars)

for tides and sea level measurements. They mounted a GPS antenna sideways on a radio tower

mast at 16 m elevation in a coastal site in Ireland and collected SNR data for about three months

in 2019 over a relatively large azimuth interval 110o-251o. An XBee wireless telemetry system

was used for short range data transfer from the mast to the computer inside the building. Their

final unit cost was ~ $500 U.S. dollars. They reported an RMS difference of 1.7 cm relative to a

nearby tide gauge at daily resolution, and an RMS of 5.7 cm over a tidal range exceeding 3 m at

spring  tides  sub-daily.  Using  an  upright  antenna  and  a  low-cost  GPS receiver  (~  $25  U.S.

dollars),  Fagundes  et  al.  (2021)  acquired  SNR  data  next  to  the  Guaíba  Lake  (Brazil)  for

approximately one year starting in 2018. They also used a wide azimuth mask (between 190o and

10o)  over the lake,  and a relatively short  antenna mount  (~ 3.5 m).  They reported the daily

averages of water level between the GNSS-IR and a nearby gauge to be in agreement at the 2.9-

cm RMS level. Their unit total cost, including solar power, was ~ $200 U.S. dollars. Purnell et al.

(2021) employed a stack of side-facing low-cost single-frequency multi-GNSS receivers (total

cost ~ $200-300 U.S. dollars including solar panel and battery) to track GPS, GLONASS and

Galileo satellites. The water surface reflections extended more than 140o in azimuth and over a

range of elevation angles up to 50o. Collecting a few weeks of SNR data at three sites along the

Saint Lawrence River in Quebec (Canada) and along the Hudson River in New York (USA), they
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show a range of 0.7 cm–1.2 cm for RMS of difference between water measurement from GNSS-

IR sites and nearby tide gauges. 

The initial GNSS-IR studies used a single zenith-pointing geodetic antenna designed to

suppress reflections (Larson et al., 2013a, Lofgren et al. 2014). These sites have the advantage of

sharing multiple uses (i.e. positioning and reflectometry). They can also observe multiple GNSS

constellations and carrier frequencies. However, as noted, they are expensive and ultimately not

as precise as a custom-designed GNSS-IR sensor. The latter can be achieved by orienting the

antenna  towards  the  water  body  (generally  90  degrees  from  zenith;  Santamaría-Gomez  &

Watson, 2017) and/or by using an inexpensive (navigation non-geodetic) antenna (Williams et

al.,  2020;  Fagundes  et  al.,  2021;  Purnell  et  al.,  2021).  Such  installations  have  far  superior

reflection characteristics at the cost of poor positioning capabilities.

Real-time GNSS observation can provide a range of future opportunities for hydrological

monitoring using low-priced receivers that can be operated unattended for a long period. Thus, it

is beneficial  to provide real-time or near real-time transmission of data from the sensor to a

remote centralized data storage and processing server. This is especially for important for remote

or  risky  environments,  or  during  extreme  weather  events  such as  floods,  storm surges,  and

tsunamis when rapid response and possible evacuation is needed. Beside remote data streaming,

such telemetry capability allows a supervised remote control of GNSS unit, i.e., uploading of

commands  to the  sensor  for maintenance  and upgrade.  Nevertheless,  because of very recent

implementation of these low-cost GNSS units in surface water level monitoring, there is still

room for improvement, particularly with regards to remote telemetry and real time applications.

Moreover, there is still a lack of information concerning their long-term performance.  

We present a prototype called Raspberry Pi Reflector (RPR) that includes a low-priced

and low-maintenance single-frequency GPS module and a GPS navigation antenna connected to

an  inexpensive  Raspberry Pi  computer  and a  cellular  modem.  The system enables  real-time

access to SNR data and remote supervision and maintenance of GPS electronics and software.

RPR builds on an earlier GNSS-IR development by adding telemetry capabilities to the offline

Multipath Hardware sensor (Fagundes et al., 2021). A unit has been successfully operating for

almost two years since March 2020 in Wesel (Germany) at a river gauge next to the Rhine river.

The GNSS antenna was mounted at approximately  12.5 m from the river level on a steel mast

tied to the gauge building. The majority of data were collected with an antenna setup in zenith
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direction.  To quantify the impact  of antenna orientation,  the antenna was  mounted  sideways

toward the river in August 2021. Sub-daily and daily water levels are retrieved using the gnssrefl

Python software package (Larson, 2021). The accuracy of water level retrieval from GNSS-IR

technique using RPR for this site is demonstrated by comparisons of sub-daily and daily water

level retrievals with data from a classical float gauge. 

2 Instrumentation

2.1 Hardware and Electronics

The  RPR  unit  consists  of  two  main  subsystems:  i)  GNSS-IR  sensor  ii)  Raspberry  Pi

microcomputer (Table 1 and Figure 1).

2.1.1 Legacy GNSS-IR Sensor (MPHW)

The GNSS-IR sensor is based on the successful Multipath Hardware (MPHW) implementation

that Fagundes et al. (2021) designed and demonstrated to monitor lake water level in Brazil. In

its turn, the MPHW is based on the Free-Standing Receiver of Snow Depth (FROS-D; Adams et

al., 2013). The MPHW includes a single-frequency L1 (1.575 GHz) Coarse/Acquisition code (C/

A) chipset  (MediaTek  MT3339)  mounted  on  an  Adafruit  GPS FeatherWing  daughterboard,

capable  of  tracking  up  to  22  satellites. MPHW also  uses  an  external  Right  Hand  Circular

Polarized (RHCP) 28-dB Chang Hong active antenna with an Ingress Protection (IP) rating 66

enclosure  which  is  waterproof  against  hose-directed  water,  rain  or  snow. The GPS board is

stacked to an Adafruit Feather Adalogger mainboard based on the ATmega32u4 microcontroller.

The microcontroller board is the intermediate layer between the GPS board and the Raspberry Pi

microcomputer. It sends out configuration and data collection commands to the GPS board and

streams  the  GPS  data  tracked  by  the  receiver  to  Raspberry  Pi.  Both  data  and  power  are

transmitted via a micro-USB cable. The MPHW GNSS-IR sensor outlined in Table 1 and Figure

1 housed inside a  IP66/67 weatherproof  enclosure.  The hardware outputs  GPS SNR data in

National Marine Electronics Association (NMEA) 0183 format.  NMEA 0183 is one of GNSS

standard protocols for real time position, velocity, time and SNR exchange with GNSS receivers.

The NMEA protocol uses a plain text encoded in ASCII and contains 19 interpreted sentences for

each epoch.  Instructions for building the GNSS-IR sensor are provided in the supplementary

information (Text S1).  For the factory default Adafruit GPS FeatherWing board, SNR data are
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recorded  with  1-dB  resolution which  degrades  the  ability  to  estimate  reflection  parameters,

especially at higher elevation angles (Larson & Nievinski, 2013). We used MPHW’s updated

GPS firmware (Fagundes et al., 2021; Adams et al., 2013) to generate the SNR data with 0.1-dB

resolution (see Text S1). Satellite azimuth and elevation angles are provided as integer values.

2.1.2 Raspberry Pi 

Open-source  sensors  in  environmental  monitoring  are  increasingly  being  built  upon  the

Raspberry Pi microcomputers.  Raspberry Shake,  a low-cost seismograph, serves as a leading

example  that  has  demonstrated  the  capability  of  Raspberry  Pi  for  long-term  motioning

(https://raspberryshake.org/).  Some recent field applications  include observing carbon dioxide

concentrations (Martin et al., 2017), and ionospheric irregularities (Rodrigues & Moraes, 2019).

The Raspberry Pi (https://www.cl.cam.ac.uk/projects/raspberrypi/), released in 2012, is an easy-

to-use, low-power, single-board tiny microcomputer that includes main input/output and Ethernet

ports, and supports open source operating systems including Linux and Raspbian. It can be used

like a personal laptop as a fully functional computer, enabling storage, analysis and visualization

of data with a vast variety of third-party packages available. We used Raspberry Pi 4 Model B

with 2 GB RAM and 64-bit quad core processor running at 1.5GHz. We used a built-in heat sink

and a thermal  pad which  allows  transferring  heat  between the  Raspberry Pi’s  CPU and the

housing case and ensure functionality of Pi computer in outdoor summer temperature. Given the

limited storage space on the Raspberry Pi and real time applications, we set up an external server

through  SSH  (Secure  SHell)  network  protocol  to  communicate  with  the  Raspberry  Pi

microcomputer  and  MPHW GNSS-IR  sensor.  Internet  connectivity  can  be  achieved  via  an

Ethernet/LAN cable,  via Wifi or an USB dongle (cellular modem). We used an LTE dongle

(Huawei E3372 4G/LTE modem) which supports LTE download and the Raspberry Pi operation

system. The Huawei E3372 dongle comes with a connector for an external antenna for better

signal reception from a local internet service provider, which was not used. 

The  current  system works  with  an  AC/DC adapter,  for  particularly  accessible  utility

power supply environments. However, the RPR can use a solar panel instead of a power supply

by connecting the Raspberry Pi to a solar panel battery system.
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Table 1. Off-the-shelf components of the Raspberry Pi Reflector (RPR). Costs are accurate as of
November 2021. The main hardware is illustrated in Figure 1. 

subsystem component function version source
price
(USD)

Raspberry Pi 
(RP)

Raspberry Pi  
 uploading commands to

GPS, data transfer
4, Model B,
2GB RAM

www.raspberrypi.org $35 

Raspberry Pi plug-in
power 

power supply 15.3W USB-C www.raspberrypi.org $8

Heat sink pack built-in heat sink FIT0542 https://www.digikey.com $1.29

GNSS-IR
sensor

Adafruit GPS
FeatherWing

a single-frequency GPS L1
C/A receiver

 Ultimate,
MediaTek
MT3339

     https://www.adafruit.com/
                 product/3133

$24.95

Adafruit Feather
Adalogger

microcontroller to interface
GPS and RP

 32u4
www.adafruit.com/product/

2795
$21.95

Chang Hong GNSS
antenna 

external active antenna, 3-
5V and 28 dB

 Chang Hong
GPS-01-174-

1M-0102

https://www.adafruit.com/
product/960

$17.95 

Fibox polycarbonate
housing

IP66/67 weatherproof
housing

Dimension: 180
x 130 x 75 mm

https://de.rs-online.com/ $24

additional
  components

  micro SD card disk storage for RP  16 -128 GB www.amazon.com $8.5 

SMA to RF adapter
cable 

for connecting the antenna to
GPS board

-
www.adafruit.com/product/

851
$3.95

USB to mini USB
plug cable

For connecting the RP to the
microcontroller 

  
-

www.amazon.com $6.71 

Figure 1. The RPR hardware array comprising: (a) Raspberry Pi 4 Model B (b) Adafruit Feather
Adalogger microcontroller (c) Adafruit GPS FeatherWing receiver (d) GPS external antenna (e)
Configuration of RPR prototype setup used. This setup uses 4G/LTE dongle modem.
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2.2 Software

Three layers of software programs are utilized to retrieve water levels from the RPR. The first

layer is based on the Arduino  Integrated Development Environment  (IDE), which is  used to

configure, set up and communicate with GPS module. The second layer is made of embedded

Python codes, which initiates the RPR, enables acquiring GPS data and storing in a text file, and

updates the RPR’s clock. And the last layer is the gnssrefl open source Python software package,

which is used for retrieving water level from SNR data (Larson, 2021). 

2.2.1 Arduino IDE

The 32u4 microcontroller is programmed via the Arduino IDE, a simple platform based on the C/

C++ language that provides a user-friendly interface. Arduino IDE enables writing, compiling

and uploading programs (often called “sketches”) from a personal computer (e.g., the Raspberry

Pi) to the microcontroler board via a USB cable. The Arduino IDE can support third-party boards

such  as  Adafruit’s  via  the  Additional  Boards  Manager  URLs  option  (see  Text  S2  in

supplementary information). We adopted the original MPHW sketch written by Fagundes et al.

(2021) to configure the GPS sensor and print the GPS data characters (in NMEA format) via a

serial event. We modified the sketch to stream only GPS data to a serial port instead of writing to

an SD card to interact with the Raspberry Pi via our Python codes (explained below). This sketch

includes  two  main  parts:  a  “Setup”  and  “Loop”.  The  “Setup”  part  establishes  serial

communication  between the  GPS module  and the  Raspberry  Pi  computer  via  a  USB cable,

configures GPS settings (e.g., GPS sampling rate) and allocates a string variable to store the

encoded GPS data. The “Loop” part keeps buffering the GPS characters in a string and streams

them to the serial port.

2.2.2 Embedded Python Codes

We  provide  Python  code  (dataPicker.py)  to  directly  read  each  serial  event  from  the

Raspberry Pi serial port and write them to a text file. We use the pySerial library to access

the serial port communication in Python. The GPS NMEA 0183 strings are written and stored as

data files on the Raspberry Pi. The Python code dataPicker.py instruct the RPR to archive

daily data files for batch post-processing in the gnssrefl software. 
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Unlike standard computers, the Raspberry Pi microcomputer does not include a built-in

real-time clock. Its clock is synchronized via WiFi or Ethernet connection and keeps its time and

date by checking the internet network. However, network issue can occur, especially when using

USB dongle and thus  time may not  kept  during  connection break.  We experienced network

issues from August 21 to 31, 2020 and from March 17 to 23, 2021. Since the Raspberry Pi could

not  synchronize  its  clock,  RPR data  were  lost.  We solved this  issue by providing a  second

embedded Python code (setPiClock.py) to keep the RPR clock updated using NMEA data

transmitted from the GPS module. 

We automate data picking and Raspberry Pi’s clock synchronization by setting up two

boot-based cron jobs  that  run these  python codes  whenever  the Raspberry Pi  boots  up (see

Supporting Information Text S1).

2.2.3 Post-processing Python Codes (gnssrefl)

Our RPR data are post-processed  using gnssrefl open-source Python software package (Larson,

2021).  Designed specifically for ground-based GNSS-IR applications,  gnssrefl allows for data

download from global GNSS archives, format conversion, data assessment, core processing, as

well as producing daily or sub-daily reflector height. It provides support for RINEX (Receiver

Independent Exchange Format) versions 2.11 and 3 as well as NMEA (NMEA, 2018). These

data files are translated and the SNR observations are extracted along with the time stamp and

satellite  azimuth  and  elevation  angles.  Tools  are  available  online

(https://gnss-reflections.org/rzones) to help the user visualize the reflection points and Fresnel

zones near a GNSS site. Although gnssrefl can analyze signals from all constellations, only GPS

L1 signals are used in this study.  gnssrefl analyzes all rising and setting satellite arcs from the

user-defined azimuth and elevation angle range. The dominant SNR frequencies are extracted

using a Lomb-Scargle periodogram (LSP) and converted to reflector heights (see section SNR

data processing for details).   

3 Test Site and Data Acquisition 

To assess the long-term performance of RPR and the accuracy of its water level estimates, we

deployed a unit within 7 m distance to a continuously operating river gauge on the Rhine river in

Wesel, Germany. In March 2021, the RPR antenna was mounted about 13 m above the ground
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surface in order to maximize the reflection zone while also keeping the antenna and electronics

safely above the water surface in all anticipated river levels. We fixed the antenna on a vertically

oriented steel pipe and then securely tightened the pipe to the gauge house's railing (Figure 2).

The RPR electronic cases were placed inside the river gauge’s building for power access.  The

RPR collects SNR data every 1 second for all available GPS satellites and streams the data every

two hours to a remote server for archiving and processing.

 The river width at our test site is ~200 m when there is no drying out at very low water

during extreme drought periods. The 13-m antenna height above the river surface allows sensing

of the first Fresnel zone with maximum dimensions of 10 m by 190 m corresponding to satellite

elevation angles ranging between 5o and 30o for each satellite ground tracks. Thus, the water

surface is fully sensed from one side to the other. However, there is a bridge to the north of the

antenna which interferes with the reflected signals. We imposed an azimuth mask to limit the

reflection data to the river surface next to the RPR antenna (Figure 2c). In August 20 (2021), we

changed the antenna orientation setup, from zenith-pointing to sideways facing the river surface

towards  the  masked  reflection  zone.  We assess  the  effect  of  such  modification  in  our  data

analysis. 

The  river  gauge  in  Wesel,  maintaining  by  German  Federal  Waterways  and Shipping

Administration (WSV), records water level at 15 minutes intervals. It is a classical float and

stilling well gauge sitting on the river bank and connected to the water via an underground pipe.

The accuracy of the river gauge records is thought to be ~3 cm (personal communication, WSV

technician). Stilling wells act as a mechanical low-pass filter, so the hourly bands suffer some

attenuation and lagging (IOC, 2006).  The level of this  section of the Rhine river is rainfall-

dominated. Discharge is high during winter and low during summer (Figure S1a). Flooding often

occurs in winter from rainfall. However, the heavy rainfall in July 2021 led to severe flooding in

Western Europe including the Rhine river.  A wind sensor,  operated by the German Weather

Service, is located in Xanten, 12.5 km from the Wesel sensors; it measures the wind speed at

hourly intervals about 10 m above the ground.  
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Figure 2. (a) Location and field setup of the RPR antenna in Wesel, Germany.  (b)  The GPS
antenna is mounted on a steel pipe, upright-pointing from March 23 (2020) to August 20 (2021)
and sideways since then. The RPR electronics are housed inside the river gauge’s building.  (c)
Footprints of the reflected GPS signals projected on a Google Earth image. Ellipses are first
Fresnel  zones  corresponding  to  azimuth  265○ -  330○ for  RPR antenna,  respectively.  Yellow
ellipses show first Fresnel zones for GPS satellite with PRN 16. Signal-to-noise ratio (SNR) data
on L1 C/A data for this satellite are shown in Figure 3.

 4 SNR Data Processing

As it  is  not  meant  for  geodetic  applications,  satellite  elevation  and azimuth  angles  are  only

integer values in the NMEA format. Since they follow a very smooth but discrete trend, the

decimal parts can be restored by linear interpolation through a de-quantization process in the

nmea2snr module of gnssrefl.  The main observable of GNSS-IR is based on the constructive

and destructive interference between the direct  and reflected GNSS signals (Figure 3a).  The

12

310

311

312

313

314

315

316

317

318

319

320

321

322

323

324

325

326

327

328

329

330

331

332

333
334
335
336
337
338
339
340
341

342

343

344

345

346

347

348



manuscript submitted to Water Resources Research

latter  always  travels  a  longer  distance  than  the  direct  signal.  For  a  horizontal  and  planar

reflection (such as a river surface), this interference pattern yields periodic oscillations in SNR

data (Figure 3b). The frequency of the oscillations primarily depends on the wavelength of the

carrier  wave  transmitted  by  satellites  (a  constant  known  a  priori)  and  the  vertical  distance

between the antenna phase center and the reflecting surface, which is the unknown of interest,

termed the reflector height (Larson et al., 2009). The direct signal effect needs to be removed by

fitting a low-order polynomial to the SNR measurements. Power spectral density analysis is used

to determine the dominant SNR frequency and thus the reflector height. Details of the theoretical

principles  and  methods  underlying  SNR-based  GNSS-IR  may  be  found  in  the  literature

(Nievinski & Larson, 2014; Roesler & Larson, 2018) as well as the gnssrefl software description

(Larson, 2021). 

Figure 3. (a) GNSS Interferometric Reflectometry (GNSS-IR) geometry for a horizontal planar
reflector.  A GNSS antenna measures the interference between the direct (blue) and reflected
(red) signals. (b) Signal-to-noise ratio (SNR) data on the L1 frequency as a function of satellite
elevation  angle  for  all  GPS satellite  tracks  with  an  azimuth  between  265o and  330o.  These
oscillation patterns in SNR data represent reflected signals. (c) Spectral analysis of the SNR data
in b). Peaks in the periodograms corresponds to the estimated reflector heights for each satellite
arc.

We imposed azimuth (265o and 330o) and elevation angle (5o and 20o) masks to isolate the

reflections to the river surface (Figure 2c). The first Fresnel zone is the ellipse located along each

satellite ground track (Larson & Nievinski, 2013). It represents the footprint of reflected signal.

It  mainly depends on reflector height (Figure 3a).  In addition to  the site-specific  masks,  the
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gnssrefl software  also  allows  the  user  to  parameterize  other  inputs.  For  completeness,  we

summarize them here. We set the noise floor in reflector height to the region between 3 m – 16

m, we require periodogram amplitudes to be larger than 8 volts/volts (see Figure 3c), the spectral

peak must be 2.7 larger than the noise, and each arc cannot last longer than 1 hour. We use a

quantity called sub-daily resolution (number of tracks per time period) which for the RPR setup

in Wesel is 9 per day.  We also averaged the sub-daily reflector heights (water level) over 24

hours to produce daily time series of water level (see section 5). 

5 Water Level Results and Discussion

The RPR instrument samples raw SNR data at 1 Hz and provides continuous and real-time SNR

data via cellular telecommunication networks to a host server. However, the time required to

retrieve  water  level  for  each  satellite  arc  with  GNSS-IR  depends  on  the  method  used  for

analyzing SNR data. Kalman filtering has been recently used to combine multiple simultaneous

satellite  arcs  for  real-time  water-level  retrieval  (Strandberg  et  al.,  2019).  The  LSP  method

requires, however, typically 20-45 minutes to retrieve a reflector height for an individual satellite

arc.  The retrieval time depends mainly on the elevation angle mask and the vertical  distance

between the GNSS antenna and the reflecting surface.  At our test site ~ forty minutes on average

is required for data acquisition and water level retrieval for an individual satellite track (Figure

4b).
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Figure 4. Detrended SNR data (after removing the direct signal) for upright RPR antenna during
(a) low river water level (1.3 m) and (b) high water level (9.45 m). The SNR data oscillate at a
higher frequency when the reflector height is higher (red line). The 1-second SNR data were
smoothed using spline interpolant. (c) Histogram showing time span of rising or setting satellite
arc for masked elevation angles shown in Figure 2c.  It takes about 30-60 minutes that signal
from a given satellite is reflecting from the river surface in our test site. 

Historical data (2010-2021) for the Rhine near Wesel indicates the 80 th percentile of day-

to-day water-level variation amounts to 20 cm (Figure S1, panel b and c). We then identified a

retrieved water-level from RPR measurements as outlier when it differed from the median value

of sub-daily estimates of water level by more than 20 cm. For days with sharp water fluctuations

following rainfall events and spring floods, we use linear least-squares regression to find the best

fit of a linear model to each RPR sub-daily water level measures. We then identified a data point

as outlier when it differs from the least squares linear model fit by more than 25 cm. 

 Figure 5a and 5b show sub-daily water level from RPR compared to water level from the

co-located stilling well river gauge. Each RPR water level point represents an average value over

the satellite descending or ascending arc. The Rhine experienced winter flooding period in mid-

February  followed by exceptional  flood event  in  July  2021.  Water  level  fluctuations  during

annual flooding can be substantial and reach levels of 8 m, which causes overbank flooding. The

RMS of differences between two sub-daily water level time series over the entire data record is
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7.6 cm.  The RPR captured  well  diurnal  variations  in  river  level  during flooding events,  for

example the July 2021 heavy rain induced flood event in Western Europe, as well as drought

periods at low water. During July 9-16 (2021), significant rainfall sharply increased the Rhine

level from 4.5 m to 8.9 m at this site. The maximum water level was observed on 16 July and

then rapidly decreased. All phases of this sequence are observed accurately by the RPR. The

quality  of  RPR sub-daily  water  level  data  is  significantly  improved  by forming  daily  mean

(Figure 5). The RMS of differences between two water level data reduces from 7.6 cm (sub-

daily) to 6 cm (daily). Daily averaging filters out random sources or error.

Figure 5.  Water level from the river gauge and RPR. (a) sub-daily  (b) daily mean. The lower
panel plots are residual between the river gauge and RPR water level measurements. The vertical
red dash line marks date of RPR antenna orientation change from upright to sideways. Heavy
rainfall in summer 2021 (July 9-16) in Western Europe resulted in a peak at a level of about 9 m
in Wesel, Germany.

5.1 Impact of Antenna Set-up Orientation 

The GNSS-IR technique has primarily been used with zenith-pointing geodetic-quality GNSS

instruments.  Previous  studies  have  shown that  a  sideways-looking antenna  will  improve the

quality of SNR retrievals (e.g., Santamaría-Gómez & Watson, 2017). We thus set a new antenna
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configuration on August 20 (2021) by tilting the antenna from zenith direction to zenith angle

90o  toward the river. The interference pattern recorded in SNR data from the sideways antenna

are more distinct, with less noise and stronger oscillation amplitudes than data from the zenith-

pointing  antenna  (Figure  6).  The increased  amplitude  follows  from the  gain  applied  by  the

antenna to  surface  reflections,  while  the reduced noise results  from the  mitigation  of  cross-

channel interference when fewer satellites are tracked. For this reason, we extended the elevation

angle mask up to 30o  for analyzing data recorded after the new antenna orientation setup. The

improvement can be better quantified by comparing the retrieved water levels from these two

datasets with the standard river gauge (Figure 5). The RMS of sub-daily residuals reduces from

7.6 cm to 3 cm for the time spans before and after the antenna orientation change. For daily

residuals, the RMS decreases from 6 cm to 1.5 cm. 

Figure  6.  Examples  of  1-second  Signal-to-Noise  Ratio  (SNR)  data  for  (a) upright  and  (b)
sideways RPR antenna setup on August 19 and 21 (2021), respectively. The SNR data are for a
GPS satellite with PRN 16, (yellow ellipses in Figure 2c). 

5.2 Wind Effect

The relation between the dominant SNR frequency and reflector  height  (GNSS-IR reflection

model)  is  based  on  the  assumption  of  the  homogeneous  flat  and  leveled  reflecting  surface

(Larson & Nievinski, 2013). Environmental forcing such as tide, tsunami and wind introduces
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surface deviations, both small-scale random roughness and large-scale systematic tilting. In their

turn, roughness and tilting affect respectively the amplitude and frequency of SNR oscillation,

thereby decreasing the accuracy of retrieved reflector  height (e.g.,  Karegar & Kusche,  2020;

Holden & Larson, 2021). In our study area, tides are absent. To examine the possible effect of

wind, we compare the differences between sub-daily RPR and river gauge time series to hourly

wind speeds. Large differences are evident during elevated windy hours (> 6 m/s) when slight

roughness  was  generated  by  turbulent  boils  on  the  water  surface  by  wind  (Figure  6).

Modification to the GNSS-IR reflection model has been suggested for sea level and significant

wave height retrieval (e.g., Alonso-Arroyo et al., 2015; Roggenbuck et al., 2019). However, this

effect is difficult to quantify for river level, in part because smaller roughness that occurs in river

surface (typically smaller than 0.3 m in height). The effect of significant wave height is more

likely to be notable if the wind blows along the azimuth the antenna is pointing (Reinking et al.,

2019). Residuals reduce after antenna orientation change. However, the use of RPR for river

level monitoring during very windy hours should be used with caution (e.g., > 6-7 m/s). For sea

level or tidal river applications where high tidal current speed and/or significant wave height are

expected, a modification of GNSS-IR reflection model is required. 

 Human-induced variations have also been shown to have a large impact on accuracy of

reflector height. Karegar & Kusche (2020) showed that the coherent power of a reflecting signal

from a parking lot next to a GNSS site increases with beginning of COVID-19 lockdown as the

reflector surface became more planar (smoother) due to absence of cars. The Rhine river is one

of the world’s busiest inland waterways where the high shipping traffic density itself (Figure S2)

and waves induced by the busy traffic could also cause additional errors in retrieved water level.

Such a site-specific effect requires extensive screening of shipping traffic, and it could be the

subject of future research.  
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Figure  7. (a)  Absolute  value  of water  level residuals  between  the  river  gauge  and  RPR
measurements. Residuals greater than 15 cm are shown with red dots.  (b) Hourly wind speed
measured 10 m above the ground surface at a station ~ 2.5 km from the RPR.

5.3 Limitations

The low-cost RPR instrument has the capability of long-term monitoring of water-level and can

be considered as part of adaptive monitoring efforts for maintaining the integrity of long-term

water level records. However, as with any monitoring technique, the RPR/GNSS-IR method has

limitations. First, the GNSS-IR technique has a footprint that depends on the antenna height and

satellite elevation angle. For a RPR with an antenna height of 1.5 m, its footprint would have an

average radius of ~40-50 m. The footprint becomes larger as the antenna is mounted higher (e.g.

~ 200 m for a 13 meter height at Wesel). For the GNSS-IR technique to work on smaller rivers,

the antenna must be carefully placed closer to the water surface, either on the banks or in a

bridge. Because of the footprint issue, it would also be necessary to rotate the antenna so that

higher elevation angles could be used.
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5.4 Potential Application in Shallow Subsidence Measurement in Deltaic Plains

Use of the RPR instrument can also be extended to deltaic environments to quantify shallow

sediment  compaction.  It  is  crucial  to  quantify  the  vertical  movement  of  deltaic  plains  and

identify sites at greatest risk from sea-level rise. In actively subsiding coastal plains such as river

deltas and coastal alluvial plains, rapid compaction of Holocene-age (around 11,500 years before

present) sediment can add a significant component to the rate of surface lowering and thus rate of

relative  sea-level  rise.  GNSS stations  and tide  gauges  anchored  in  unconsolidated  Holocene

sediment  record the contribution of compaction occurring in sediment  below their  anchoring

depths,  as  well  as  contributions  from  deeper  processes  (e.g.,  Keogh  &  Törnqvist,  2019).

However, ground surface changes related to shallow displacements that occur within the shallow

layer  between the surface and the base of  the tide  gauge or  GNSS monument,  often  called

shallow sediment compaction, is disregarded because this process has been difficult to quantify

(Figure 8). Recent studies showed that the rate of shallow compaction is comparable to or larger

than the rate of global sea-level rise. Thus, estimates of future flood risk and land loss in regions

of rapid Holocene sedimentation may be underestimated if not accounted for (Jankowski et al.,

2017; Keogh and Törnqvist, 2019; Karegar et al., 2021). Shallow compaction has been recently

quantified using GNSS-IR technique at available geodetic GNSS sites in two coastal  regions

with thick Holocene deposits, the Mississippi Delta in North America and the eastern margin of

the North Sea in Europe (Karegar et  al.,  2021).  Since the primary aim of existing geodetic

GNSS networks is tectonic geodesy and survey engineering, geodetic-quality GNSS antennas are

not  ideally  located  for  purposes  (i.e.,  close  to  a  planar  natural  and  preferably  bare  ground

surface).  The  RPR  instrument  offers  a  low-cost,  simple  and  high-precision  method  for

simultaneously quantifying rate of shallow subsidence and rate of relative sea-level rise.
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Figure 8. Schematic sketch of RPR installation in deltaic plains that measures (a) antenna height
form  ground surface (b) antenna height from water surface. Analysis of reflection data from
ground is  used for  estimating  shallow vertical  land motion  (displacements  that  occur  within
RPR’s foundation structure). The compressible young Holocene age sediments are underlain by
non-compressible old Pleistocene age sediments. Analysis of reflection data from the sea surface
can be used to estimate relative sea-level change: the sum of absolute sea-level change and deep
vertical land motion (displacements that occur beneath RPR’s foundation structure).

A RPR set-up shown in Figure 8 can provide corrected rate of relative sea-level rise for

the effect of shallow sediment compaction. In this configuration, the RPR antenna receives a

reflected signal from the ground surface and thus the reflector height changes include the effect

of ground surface changes related to shallow displacements that occur above the base of the RPR

monument (building in Figure 8).  The RPR also receives reflected signal from the sea surface.

The reflector height changes relative to the sea level is attributed to relative sea-level change.

Note that in this case, the RPR relative sea-level change measures include deep subsidence that

occur beneath the structural foundation of its monument as its foundation moves relative to the

sea  level.  However,  precise  geodetic-quality  GNSS  instrument  and  conventional  GNSS

positioning analysis is still needed if determining deep subsidence is desired. In many situations

where it is desirable to estimate rate of relative sea-level rise and land loss, a dense regional

network of RPR sites can be developed. This is particularly important given the need for cost-

effective responses to the effects of climate change.
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6. Summary and Concluding Remarks

With floods and droughts becoming increasingly frequent as climate change worsens, there is a

compelling need to improve hydrological data collection. Inexpensive open-source hydrological

sensors facilitate the acquisition of new in situ data. In particular, inexpensive novel sensors are

increasingly being developed for sea level and river water monitoring.  We have developed a

cost-effective water level sensor called Raspberry Pi Reflector (RPR), using Global Navigation

Satellite System Interferometric Reflectometry (GNSS-IR). It has been demonstrated capable of

measuring river level with centimeter level accuracy. Since the GNSS-IR instrument is not in

contact with the water, it can be operated safely in extreme weather with lower operational costs.

Our RPR sensor streams near real-time raw data allowing continuous water level measurement.

Only  a  single-time  site  visit  is  required  for  installation.  The  RPR  consists  of  two  main

subsystems: (1) GNSS-IR sensor that includes single-frequency GPS receiver, microcontroller

and external GPS antenna, and (2) Raspberry Pi microcomputer and cellular modem. We have

been operating a unit on the Rhine river since March 2020 to examine the long-term performance

of the RPR. The river level measurements from RPR were compared with co-located river gauge

measurements. We obtained an overall accuracy of 3 cm for sub-daily water level measurement

for the RPR setup with an antenna rotated 90 degrees from zenith.  The RPR does not need

infrastructure such as a bridge or pier for installation, and it costs less than $150 U.S. dollars.

However, the RPR may not work well in narrow rivers (< ~ 50 m width) or in rivers located in

steep valleys where satellite signals are blocked at low elevation angles. At our Wesel site, the

unit  successfully  recorded  flooding  events  associated  with  July  2021 flash  rainfall  event  in

western Europe and other heavy rainfall events. The RPR sensor can be applied to a variety of

areas including rivers, lakes, dams and sea. It could aid stream flow estimation, and through pairs

of devices along the river allows measuring river slope changes. This sensor could also be used

to simultaneously quantify shallow sediment compaction in deltaic plains and monitor relative

sea level change. Such potential application can provide a more complete picture of land loss and

relative sea-level rise in these regions.   
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RPR data processed in this study are archived at data server at the University of Bonn, Institute
of  Geodesy  and  Geoinformation  (https://uni-bonn.sciebo.de/s/gQLub35odUc17eL).  The  wind
speed  data  are  available  from  the  German  Weather  Service  (DWD)  ftp  server
https://opendata.dwd.de/climate_environment/CDC/observations_germany/climate/hourly/wind/
recent).  The last  thirty day river gauge data in  Wesel  is  available  from the  German Federal
Waterways  and  Shipping  Administration  (WSV)  web  site
(https://www.pegelonline.wsv.de/webservices/files/Wasserstand+Rohdaten/RHEIN/WESEL/).
Access  to  the  gnssrefl is  available  from GitHub (https://github.com/kristinemlarson/gnssrefl),
pypi.org   (https://pypi.org/project/gnssrefl)  , or via a Jupyter notebook implementation in a Docker
image (https://www.unavco.org/gitlab/gnss_reflectometry/gnssrefl_jupyter). Guide to assemble a
RPR sensor is provided in Supplement Information. 
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Figure S1. (a) 15-minutes records of river level from the river gauge at Wesel, Germany.
(b)  daily range values. The horizontal red line marks daily range of 20 cm.  (c)  relative
frequency histogram for daily range data.
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Figure S2.  Footprints of the reflected GPS signals and shipping traffic in the Rhine river.
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Text S1: Installation guide for RPR

1. Raspberry Pi operating system installation

Raspberry Pi does not have internal disk and built-in Operating System (OS). To set up
Raspberry Pi, an operating system needs to be installed onto an SD card. OS Image file is
available at the official Raspberry Pi website. Installation instruction can be found here:
https://www.raspberrypi.com/software/ 

Once the Raspberry Pi boots, open Raspberry Pi Configuration under Applications Menu
> Preferences  >  Raspberry Pi  Configuration.  In  the “Interfaces”  tab,  set  SSH, VNC,
Serial Port, Serial Console to enabled. Secure Shell (SSH) is a commonly used protocol
for providing a secure channel between two computers. We can use SSH to connect from
a  Linux  computer  or  from the  Mac  terminal  to  the  Raspberry  Pi,  without  installing
additional  software.  The  Virtual  Network  Connection  (VNC)  server  is  enabled  for
viewing GUI desktop of Raspberry Pi remotely via VNC viewer software installed on a
server  computer.  The  GPS  module  sends  and  receives  NMEA  data  via  the  serial
communication port to the Raspberry Pi. 

After setting up the Raspberry Pi, make sure that it has access to the internet.

2. Installing Arduino integrated development environment (IDE)

2.1 Download the latest version of Arduino IDE (1.8.16) from Arduino website. Note that
the processor of Raspberry Pi 3 (4) is a 32- (64)- bit, 700 MHz system on a chip, which is
built on the ARM11 architecture, thus we recommend installing “Linux ARM 32 bits”
download option: https://www.arduino.cc/en/software
j

2.2 Uncompress downloaded file:

tar -xf arduino-1.8.16-linuxarm.tar.xz

2.3 Change your current directory to the created folder and install the Arduino IDE using:

cd  arduino-1.8.16

sudo ./install.sh

3. Assembling GPS module (MPHW) and connecting to the Raspberry Pi:

General  instructions  for  soldering  Adafruit  GPS  FeatherWing,  Adafruit  Feather
Adalogger microcontroller and stackable header can be found here (follow Section 2.1 in
“Tutorial Adafruit GNSS-R.pdf”):

https://github.com/fgnievinski/mphw/blob/master/docs/Tutorial%20Adafruit%20GNSS-
R.pdf

Plug the assembled GPS (MPHW) module into Raspberry Pi’s USB socket using a USB
to Micro USB cable. 
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4. Downloading Arduino and python codes:

4.1  Change your current directory to:

cd /home/pi

4.2 Download Arduino and python codes from GitHub using git commad:

git clone https://github.com/MakanAKaregar/RPR.git

A new directory (RPR) is created under /home/pi  

4.3 Create a new directory for archiving RPR’s daily NMEA data:

mkdir /home/pi/RPR/data

5. Adding and installing Adafruit board support package for Arduino IDE

To enable the Arduino IDE to communicate with Adafruit Feather 32u4 Adalogger board
we will need to install a board support package that includes Adafruit FeatherWing driver
that allows us to upload Arduino sketch via the Arduino IDE. 

5.1  Start  the  IDE  and  navigate  to  File  >  Preference.  Under  “Settings”  tab add  the
following URL in “Additional Boards Manager URLs”

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json

5.2 Install Adafruit FeatherWing board

Tools > Board > Boards Manager > Contributed.  Select  “Adafruit  AVR Boards” and
click “Install” button.

5.3 Quit and reopen the Arduino IDE. Under Tools > Board, select “Adafruit Feather
32u4”

5.4 Under Tools > Port, select “/dev/ttyACM0”

5.5 Compile and upload the Arduino sketch:

- Open MPHW.ino sketch available from /home/pi/RPR/ideCodes/ in the Arduino
IDE: File > Open

- ensure that board and port are correct

- compile and upload the MPHW.ino to the Adafruit Feather 32u4 board under Sketch >
Upload

5.6 Test GPS NMEA data streaming/transmitting to the serial port on terminal

Put the GPS antenna near or outside a window to get satellite signals. You can test if RPR
setup is done correctly by the following command:

5
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cat /dev/ttyACM0

This should give you results resembling the following outputs in your terminal:

$GPGGA,171540.000,5043.6373,N,00705.2537,E,1,09,0.85,63.6,M,47.7,M,,*5B
$GPGSV,4,1,13,24,77,293,26,19,41,093,39,15,41,182,15,12,38,224,29*70
$GPGSV,4,2,13,17,34,059,41,37,30,161,,13,23,151,29,10,23,295,16*70
$GPGSV,4,3,13,23,20,259,22,14,11,055,32,25,07,233,18,01,05,020,27*7D
$GPGSV,4,4,13,32,05,320,18*47
$GPRMC,171540.000,A,5043.6373,N,00705.2537,E,0.04,2.26,151121,,,A*6F
$GPRMC,171540.000,A,5043.6373,N,00705.2537,E,0.04,2.26,151121,,,A*6F
211115.log

$GPGGA,171541.000,5043.6373,N,00705.2540,E,1,09,0.88,63.6,M,47.7,M,,*57
$GPGSV,4,1,13,24,77,293,26,19,41,093,39,15,41,182,16,12,38,224,29*73
$GPGSV,4,2,13,17,34,059,41,37,30,161,,13,23,151,28,10,23,295,16*71
$GPGSV,4,3,13,23,20,259,22,14,11,055,32,25,07,233,18,01,05,020,27*7D
$GPGSV,4,4,13,32,05,320,18*47
$GPRMC,171541.000,A,5043.6373,N,00705.2540,E,0.02,25.95,151121,,,A*55
$GPRMC,171541.000,A,5043.6373,N,00705.2540,E,0.02,25.95,151121,,,A*55
211115.log

6. Updating GPS module’s firmware 

To  generate the  SNR  data  with  0.1-dB  precision  we  should  update  Adafruit  GPS
FeatherWing’s  firmware.  To  perform  the  firmware  update,  we  require  a  Windows
computer  to  install  The  GlobalTop  Flash  Tool  software  which  allows  updating  the
firmware  of  GPS  chip.  The  custom  firmware  for  the  MediaTek  GPS  can  be  made
available upon request. After updating the GPS firmware, plug the GPS module into the
Raspberry Pi and redo steps from 5.3 to 5.6.

You can test if the GPS firmware is upgraded by the following command:

cat /dev/ttyACM0

This should give you the following sentences in your terminal:

$GPGGA,172644.000,5043.6391,N,00705.2406,E,1,5,1.50,66.1,M,47.7,M,,*67
$GPGSV,2,1,06,24,82,295,26.2,12,44,227,32.4,19,42,087,44.2,17,32,054,42.
4*7E
$GPGSV,2,2,06,13,18,152,34.6,23,17,255,24.6*76
$GPRMC,172644.000,A,5043.6391,N,00705.2406,E,0.14,290.38,151121,,,A*63
$GPRMC,172644.000,A,5043.6391,N,00705.2406,E,0.14,290.38,151121,,,A*63
211115.log

$GPGGA,172645.000,5043.6391,N,00705.2406,E,1,5,1.50,65.9,M,47.7,M,,*6D
$GPGSV,2,1,06,24,82,295,25.0,12,44,227,32.3,19,42,087,44.4,17,32,054,42.
0*7A
$GPGSV,2,2,06,13,18,152,34.4,23,17,255,25.2*71
$GPRMC,172645.000,A,5043.6391,N,00705.2406,E,0.14,290.38,151121,,,A*62
$GPRMC,172645.000,A,5043.6391,N,00705.2406,E,0.14,290.38,151121,,,A*62
211115.log
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7. Installing some python packages:

Make sure your Raspberry Pi is connected to the internet. We will need a few additional
python packages to make the python scripts work. Running the following command from
terminal will install these libraries:

6.1  sudo apt-get update
6.2  sudo pip3 install pyserial
6.3  sudo pip3 install timezonefinder
6.4  sudo pip3 install pytz
6.5  sudo pip3 install pynmea2

8. Setting crontab jobs

We automate data picking and Raspberry Pi’s clock synchronization by setting up two
boot-based cron jobs that run python codes whenever the Raspberry Pi boots up.  To
create a crontab file, execute the following commands in a terminal:

8.1 crontab -e

You can select a text editor to make changes to the crontab file. Select your desired text
editor (e.g. nano, vi ...).

8.2 Add these lines to the crontab file: 

#to parse RPR nmea data into daily files
@reboot sudo /bin/python3.7 /home/pi/RPR/pyCodes/dataPicker.py 

#to sync Raspberry Pi’s clock with GPS time (it is local time)
@reboot sudo /bin/ python3.7 /home/pi/RPR/pyCodes/setPiClock.py

Note that for Raspberry PI 3 B and B+ the python source code is at  /bin/python3.7
and for Raspberry PI 4 at /usr/bin/python3.7

A simple code can be added to the time-based cron job scheduler for compressing daily
NMEA files and transfer to a server. For example, the python code  gzipForCron.py
will be run every day at 1:00 AM. 

#to compress daily RPR files and transfer to a remote server
00 01 * * * /bin/python3.7 /home/pi/RPR/pyCodes/gzipForCron.py

Ensure that you included the correct file path in your crontab command. 
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